PPC’s SMART Practice Aids® - Risk Assessment (without Field Work) Integration with Engagement CS (Best Practices)

If you are using PPC’s SMART Practice Aids – Field Work, refer to separate documentation for PPC’s SMART Practice Aids – Field Work integration with Engagement CS.

Select a SMART Practice Aids client engagement for the first time in Engagement CS

Prior to launching SMART Practice Aids, open a client engagement in Engagement CS. Then click the SMART Practice Aids icon, or select Tasks, PPC, SMART Practice Aids.
When SMART Practice Aids opens, you will be prompted to select an existing SMART Practice Aids engagement or to create a new one:
If you choose an existing engagement, the *Open Engagement* dialog box displays all available engagements. Select one and click Open.

<table>
<thead>
<tr>
<th>Engagement Name</th>
<th>Status</th>
<th>Last Modified Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010 Audit</td>
<td>In Progress</td>
<td>6/20/2011</td>
</tr>
<tr>
<td>2010 Audit for Rollforward</td>
<td>In Progress</td>
<td>6/21/2011</td>
</tr>
<tr>
<td>2011 Audit</td>
<td>In Progress</td>
<td>6/16/2011</td>
</tr>
<tr>
<td>2011 Audit for Rollforward</td>
<td>In Progress</td>
<td>6/16/2011</td>
</tr>
</tbody>
</table>

Selecting and saving a SMART Practice Aids engagement will then associate it with the client engagement in Engagement CS. The next time you open the client engagement in Engagement CS, then open the SMART Practice Aids application through Engagement CS, the Open Engagement dialog box will appear, and the associated SMART Practice Aids engagement will already be selected for you. You can either click Open to open this engagement or select a different engagement to associate with your client engagement in Engagement CS.

**Database location and multi-user access**

On the Open Engagement screen in SMART, there is a choice to allow multiple users for this engagement. This allows multiple staff people to be working in the same client engagement file in SMART at the same time. A best practice for using multi-users is to use a shared database installation. This will give you even more flexibility so you can work on a local computer drive, browse to a network folder, or browse to a peer-to-peer network location of laptops connected in the field. Complete installation instructions for the shared database are available on our customer help center at support.rg.thomsonreuters.com. Additional information for multi-user help can be found in the help system of SMART Practice Aids by clicking on the Multi-user Help button.
Selecting the *Create a New Engagement* option will display the Engagement Setup wizard in SMART. Enter the client information, click Next to complete all setup screens. Once you have created and saved the engagement, it will be associated with the corresponding client engagement in Engagement CS.
Generate Planning Forms, Audit Programs, and Other Documents

Using SMART Practice Aids – Risk Assessment, completed planning forms, tailored audit programs and other documents are generated out of the software application as Practice Aids documents. To generate documents in SMART Practice Aids, select Generation in the drop-down on the left-hand navigation. Select the type of document desired under Generate Documents in the left navigation pane, select one or more documents you wish to generate, and click Create Practice Aids.

The PPC forms will be stored directly in the client engagement in Engagement CS. The path that appears is already linked to the CS file so there is no need to browse or type in a path location, click OK to use the existing path.
The first time you generate PPC forms from SMART Practice Aids, the documents will be housed in the Not yet filed folder. It is very easy for you to use click and drag to move the documents to any folder location that you choose for organization.

Another option to organize the documents is to use File/Process Unfiled Workpapers. Select Move this workpaper to another folder and click Next.
In Workpaper Properties, the Rollforward setting is automatically set to Replace from SMART Practice Aids.
Making Changes after the Documents are Generated

Using SMART Practice Aids – Risk Assessment, completed planning forms, tailored audit programs and other documents are generated out of the software application as Practice Aids documents. Firms have found that when reviewers perform a review of the planning forms and tailored audit programs in SMART Practice Aids before the engagement work begins, the process is streamlined and more efficient. Should it be necessary to make changes to the planning forms or audit programs after the engagement work beings, there are a few ways to accomplish this, depending on the complexity of the change. Please read this entire section to learn the benefits of using the Update SMART Engagement feature when making changes to generated audit programs.

As a best practice, making changes in SMART Practice Aids ensures that client data is correct and complete for rollforward to next year. You can then generate one or more of the planning forms and audit programs.

If the change affects information on planning forms, from Generate Planning Forms, simply select the forms that have changed using the green checkmarks, and create those selected Practice Aids documents. This will create new, updated planning forms in the Not yet filed folder in the client engagement in Engagement CS.

If the change affects audit programs, from Generate Audit Programs, simply select the audit programs that have changed using the green checkmarks, and create those selected Practice Aids documents. This will create new, updated audit programs in the Not yet filed folder in the client engagement in Engagement CS. Any existing step sign-offs and workpaper references in the previous Word document will not be retained.
In Engagement CS, use File/Process Unfiled Workpapers. Select Replace existing workpaper and click Next.
Perhaps the change affects an audit program, but the engagement work is already in process and some procedures on that program have already been performed. The auditor should use their judgment to determine if it is appropriate to create a new, updated audit program, or to change procedures on the existing audit program.

To insert a procedure in the existing audit program Practice Aid Word document created from SMART Practice Aids – Risk Assessment, insert a row where the procedure should be added. To do this, position the cursor where the row should be inserted and select Table/Insert/Row Below (or Row Above).

Use the Update SMART Engagement feature when you have made changes to a Practice Aid audit program document generated by SMART Practice Aids and you want the changes applied to the version within SMART Practice Aids. You can initiate the update from the PPC menu within the document in Microsoft® Word or from the Tools menu within SMART Practice Aids. Refer to the help topic *Update SMART Engagement* for more information. This feature is only available on audit programs generated from SMART – Risk Assessment.
**Engagement Rollforward**

With *Engagement Rollforward*, you can create a new engagement that is based on a prior period engagement and bring forward settings and customizations from the prior period engagement. You also have the option in SMART Practice Aids to bring forward planning form responses, identified risks, and risk assessments, as well as audit approaches from the prior period engagement. In SMART, you can also view significant PPC changes to planning form questions and audit procedures and see the differences between current period audit procedures and procedures used in the prior period.

To prepare for rollforward, in Engagement CS, ensure that the Rollforward setting is Replace from SMART Practice Aids on all documents used in SMART. Select Workpaper Properties from the Edit menu or right click menu.
Start by opening the client engagement in Engagement CS and select Roll Forward from the File menu. Detailed instructions can also be found in the Help menu in Engagement CS.

On the Roll Forward Options dialog box, indicate whether you want to retain workpaper assignments and staff privileges. Then click Continue. Verify and complete the information on the Roll Forward – Engagement Properties dialog box and click Next.

The Roll Forward - Workpaper Settings dialog box lists each of the workpapers and the applicable Roll Forward setting for each one. To change the setting for a workpaper, click the drop-down arrow and select a setting from the list:

- Include
- Exclude
- Replace from PPC Template
- Replace from selected engagement
- Replace from SMART Practice Aids
Documents that were added from the Checkpoint Tools for PPC, such as an engagement letter, will be replaced with the newer version from the PPC template. Documents such as checklists and audit programs that came from SMART Practice Aids will again be replaced from SMART Practice Aids next year. When you are satisfied with all settings, click Next to continue.

On the Roll Forward - Replace Workpapers dialog box, review the workpaper titles listed in the Replacement Workpaper column. To change a replacement workpaper title, select the title and click Select Replacement Workpaper.

On the Roll Forward - Rename Workpaper dialog box, you have the option to change the workpaper reference or name for any workpaper used by the engagement. Click in a field and edit or replace the reference or name. Click Next to continue.

On the Roll Forward - Finish dialog box, click Finish to initiate the final steps of the Rollforward process. You also have the options to return to a previous page of the dialog box or to cancel.

When the Engagement Properties window appears, review the information on each tab and make any applicable changes. Then click OK.

Once the Roll Forward in Engagement CS is complete, you will automatically be prompted to rollforward the related SMART Practice Aids engagement.
Selecting Yes will launch SMART Practice Aids and open the client engagement file that was linked to the client engagement in Engagement CS.

Complete the rollforward process in SMART Practice Aids. See Engagement Rollforward in Help menu in SMART Practice Aids for more details.
In the rolled forward client engagement in Engagement CS, documents with the Roll Forward setting Replace from SMART Practice Aids have been replaced with a placeholder. After completing the PPC Forms in the rolled forward client engagement in SMART for the second year, the generated documents will automatically be placed in the location of the placeholder, and not in the Not yet filed folder.

Documents such as an engagement letter with the Roll Forward setting Replace from PPC Template have been replaced with the newer version from Checkpoint Tools.
Using Checkpoint Tools and PPC’s SMART Practice Aids in Virtual Office CS

What is Virtual Office CS?
Virtual Office CS, included in the CS Professional Suite from Thomson Reuters, offers anytime, anywhere remote software access, relieving firms of the IT burden and ensuring business continuance. The Virtual Office CS environment provides the full line of CS Professional Suite tax and accounting software, Checkpoint Tools, PPC’s SMART Practice Aids, and select Microsoft products.

Getting Started using Checkpoint Tools and PPC’s SMART Practice Aids in Virtual Office CS:

With Virtual Office CS, users can access their licensed Checkpoint Tools and PPC’s SMART Practice Aids products without having to download and install to a local workstation. Follow these important steps to get started:

✓ Each licensed user of Checkpoint Tools and PPC’s SMART Practice Aids must have an active order for their licensed products assigned to their Checkpoint User ID in the Checkpoint User Administration System. For information on assigning users, check with your firm’s Site Administrator, or refer to the instructions at http://support.rg.thomsonreuters.com/checkpoint.asp.
✓ To place a new order for Checkpoint Tools or PPC’s SMART Practice Aids, contact your sales representative at http://ria.thomsonreuters.com/replocator/.
✓ In Virtual Office CS, launch Checkpoint Tools, either by clicking the icon on the VO Desktop or by inserting a PPC document into Engagement CS.
✓ In the Checkpoint Tools main application, select Tools/VO Options/Set/Update Login Information.
✓ On the Set/Update Account Information screen, enter your Checkpoint User Name and Checkpoint e-mail address for that User Name and click the Submit button.
✓ If the VO user does not see an icon for Checkpoint Tools, the NetStaff Administrator should assign the Staff permissions to the application Checkpoint Tools:
  1. Click on the NetStaff tab.
  2. Select Users on the left.
  3. Next to the user login, click Permissions in the Actions column.
✓ To use PPC’s SMART Practice Aids in Virtual Office CS, you must request to have this product added to Virtual Office CS. Please call CS Customer Service at (800) 968-0600, option 1.

Integrating Engagement CS and Checkpoint Tools in Virtual Office CS:

In Engagement CS, select File/New/Document, select the PPC tab, select Document from Checkpoint Tools, and then click the Continue button. Users must be properly licensed and assigned to the Checkpoint Tools product they are selecting a document from. If they do not have permissions for the product, they will not be able to edit the document.
Integrating Engagement CS and PPC’s SMART Practice Aids in Virtual Office CS:

To integrate these applications directly, PPC’s SMART Practice Aids must be launched from the icon within the Engagement CS client. Users must be properly licensed and assigned to each PPC’s SMART Practice Aids modules they want to use. Follow these important steps to get started:

✓ The first time you select PPC’s SMART Practice Aids in Virtual Office CS, you will be prompted to provide information that helps verify which products you are licensed to use (for example, SMART Practice Aids - Risk Assessment or SMART Practice Aids - Internal Control).

✓ In SMART Practice Aids, select Tools/VO Options/Set/Update Login Information.

✓ In the Set/Update Account Information screen, enter your Checkpoint User Name and Checkpoint e-mail address for that User Name and click the Submit button.

✓ In subsequent launches of the product from Virtual Office CS, if newly licensed products are not available, you can refresh your licensed products list by selecting VO Options from the SMART Practice Aids Tools menu, and then click Refresh Product List.

✓ When you access SMART Practice Aids from Virtual Office CS, most functionality works the same way it works for a local installation, but with a few minor differences. For example, the option to point to another database is not available since you will already be linked to a firm SMART Practice Aids database that is set up for you.

Product Support:
For assistance with Virtual Office CS or Engagement CS, please call 800.968.0600.
For assistance with Checkpoint Tools or PPC’s SMART Practice Aids, please call 800.431.9025